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MoTeC

Introduction

Introduction

The PDMs replace conventional relays, fuses and circuit breakers by

providing electronically switched power to the various electrical systems in the
vehicle, including motors, lamps, ECUs and data systems. This simplifies
wiring and switch requirements, while increasing reliability.

There are four PDM versions: PDM16, PDM32, PDM15 and PDM30.

Throughout this manual all versions will be referred to as the PDM except
where details specific to a particular version are discussed.

Features

PDM16 PDM32 PDM15 PDM30
Inputs 12 23 16 16
8 Amp Outputs 8 24 7 22
20 Amp Outputs 8 8 8 8
Connectors Autosport Waterproof connectors

M6 stud

Case size
Length 130 mm 180 mm 107 mm 107 mm
Width 60 mm 60 mm 133 mm 133 mm
Height 28 mm 28 mm 39 mm 39 mm

e [Each output is over-current, short circuit and thermal overload protected
e OQOutputs are programmable in 1 A steps

e Outputs are controllable via a combination of switch inputs, CAN

messages and logic functions
e Switch inputs are ranging from 0 to 51 V, resolution 0.2 V

e Performing up to 200 logic operations using operators like Flash, Pulse,
Set/Reset, Hysteresis, Toggle, And, Or, Less than, Greater than, Not equal
to, Equal to, True, False etc.

e Performing functions such as flashing indicator lights and controlling

thermofan and fuel pump

e Using logic functions to selectively turn off systems during low battery
voltage or engine starting, reducing drain on the battery




2 Introduction

¢ Providing full diagnostic information, including output currents and
voltages, input voltages, and error status

e Transmitting diagnostic information via CAN to a display or data logging
device or monitoring directly on a PC

e Protected against unauthorised access by a password feature.
Compatibility

e All MoTeC Dash Loggers: SDL, ADL2, ADL3, ACL

e 'Hundred series’ ECUs: M400, M600, M800, M880

Accessories

e MoTeC UTC (USB to CAN adaptor) #61059
(Note: PDMs are not compatible with MoTeC CAN cable)

System Overview

L,

— | Battery
Battery Input
oo P CAN bus
o ——» Inputs
e pus PDM CAN >
Switches
Outputs
vVYY ECU
Other

Motors Lights Devices
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Installation

Mounting

When mounting the PDM take into account that the PDM may get very hot
during operation.

Ensure the PDM is mounted in a well ventilated area and not against a hot
surface. For case dimensions see Mounting Dimensions.

The internal temperature is highly dependent on ambient temperature and
also on the total load current—a higher current will cause a higher
temperature.

Tip: The internal temperature can be checked in PDM Manager (see
Operation) or transmitted via CAN to be logged. Allow for sufficient time
for the temperature to stabilise. This may take 30 minutes or more.

If the internal temperature of the PDM exceeds the specified maximum values
(see Specifications), cooling may be achieved by one or more of the following:

¢ relocating the PDM to a cooler mounting position

e increasing air circulation around the PDM case

e ducting cool air over the PDM case

¢ fitting a heatsink to the back surface of the PDM case
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Wiring
()
Jj Jj I\IJt Starter Alt t
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Battery Positive
Battery positive is supplied to the PDM via the single pin connector to suit wire
sizes 16 mm?® (6#) or 25 mm? (4#).

The PDM16 and PDM32 use an Autosport connector, PDM15 and PDM30
use a 6 mm eyelet to suit the wire size.

The wire gauge should be chosen according to the wire temperature limit and
acceptable voltage drop. Tefzel wire must not exceed 150 °C.

The temperature of the wire is affected by the ambient temperature, air
circulation, current, wire gauge, the temperature of any surrounding wires and
the covering sheath.

See Wire Specification and Connectors and Pinout for details.

Battery Isolator Switch
Battery positive must generally be connected via an isolator switch or relay.

The isolator must isolate the battery from all devices in the vehicle including
the PDM, starter motor and alternator. The isolator must be rated to handle
the starter motor current.

When the battery is isolated, the engine may continue to run due to power
supplied by the alternator. To avoid this, the isolator switch should have a
secondary switch that is connected to a shutdown input on the ECU.
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If the ECU does not have a shutdown input, the switch can be connected to a
PDM input. The PDM can then turn off power to the ignition system or the
ECU, which will cause the engine to stop.

Battery Negative

Both of the Batt— pins should be wired to battery negative via 20# wire.

These pins normally only carry the very low operating current, however during
a load dump they carry the load dump current which may be 50 ampere or
higher.

CAN Wiring

The PDM communicates over CAN with other devices connected to the same
CAN bus. The CAN bus must be wired according to CAN Bus Wiring
Requirements.

The PC also communicates to the PDM via the CAN bus. See Connecting the
PDM to a PC.

Input Wiring

The PDM Switch Inputs are intended for use with a switch that is directly
wired between a PDM input pin and a PDM 0 V pin. Each input has an
internal 10 kilo-ohm pull-up resistor to Batt+.

If it is required to connect a switch that is wired to another system in the
vehicle, ensure that the voltage levels are set appropriately as there may be
ground voltage variations between devices.

Tip: If standby current is important, wire the switches so that they are
normally open during standby. This will reduce the standby current.

Input Switch Connected to Battery

When an input is driven from a device that switches to battery, the switch
should if possible, be rearranged so that it switchesto 0 V.

If the signal comes from an electronic device such as an ECU that has an
output that can only switch to battery (e.g. a signal that indicates when to turn
the fuel pump on), this might not be possible. In this case an external pull-
down resistor is required. The resistor should be 1500 ohm 0.25 watt and
should be connected between the input pin and the 0 V pin.

The input trigger levels should be setto 4 V and 5 V to guarantee correct
triggering for all possible battery voltages.
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Output Wiring

All outputs are high side type outputs; they switch Batt+ to the output pin.
They all have hardware thermal overload protection, fault logic and over-
current logic.

Paralleled Outputs

Two or more output pins can be connected in parallel to increase current
capacity. Outputs that are connected in parallel must all be of the same type;
either all 8 Amp or all 20 Amp outputs.

Wire Gauges

The wire gauge must be chosen to suit the current consumed by the
connected device and to ensure that the voltage drop is acceptable. On long
runs it may be necessary to use a heavier gauge wire to minimise voltage
drop.

The wire gauge must also be compatible with the connector pin; using a
smaller than recommended wire gauge may result in a poor crimp.

Suitable wire gauges are 24# to 20# for the 8 Amp outputs and 20# to 16# for
the 20 Amp outputs. See Wiring for details.

Output Devices

Windscreen Wipers

The PDM can drive windscreen wiper motors; however the PDM cannot be
connected to both the fast and slow motor windings at the same time. The
voltage generated by the slow winding during fast operation will cause braking
of the motor and possible damage to the PDM.

A wiper unit can be wired in a number of ways. The following schematics are
shown for ‘common-ground' wiper units. For ‘common-positive' wiper units the
schematics must be adjusted accordingly.

1. OEM Controller Method

Output ———»

PDM .
OEM @Pﬁl

controller F Home
97

Control — > Park
Switches ——» Switch
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The wiper unit can be wired using an OEM wiper controller with the PDM
supplying the power only.
The OEM controller performs the intermittent and motor braking functions.

2. Two Switch Method

Output o
PDM T off

The wiper unit can be wired in a simple two switch arrangement; one switch
for power and the other to select fast or slow. The PDM supplies power only.

Wiper motor braking is performed by the combination of the park switch and
the on/off switch.

This arrangement cannot perform intermittent operation since the wiper will
not park if the PDM simply removes power.

The switches must be able to handle the wiper motor current (typically
4 ampere).

3. Relay Method

Relay

SCC?’?tIZOI Output ———»N\/\/\—

witches

—> PDM

—p Output )OO&%

TﬂOﬁ =
Park
Switch

The two switch method can be modified for intermittent operation by replacing
the on/off switch with a relay. The PDM controls the relay to perform the
intermittent function. This requires two PDM outputs; one to supply power and
the other to control the relay.

Motor braking is performed by the combination of the park switch and the
relay switch.

The PDM must be configured with the appropriate logic to perform on/off and
intermittent operation based on the state of the control switches.
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Slow operation can be achieved using the switch or using intermittent
operation to give a similar effect which avoids the need for a high current
switch.

The fast/slow switch and on/off relay must handle the wiper motor current
(typically 4 ampere). The control switches can be low current types since they
only connect to PDM inputs.

4. Direct Method

Output 9

PDM

Input

Control ——
Switches 3

The wiper unit can be wired directly to the PDM as long as it is only connected
to one output.

In this method the park switch is wired directly to a PDM input so the park
logic must be configured in the PDM.

This method requires the use of Output 9 which performs motor braking. The
PDM performs motor braking by momentarily shorting the output to ground
when the output turns off.

The PDM must be configured with the appropriate logic to perform on/off and
intermittent operation based on the state of the control switches.

Slow operation can be achieved using a switch between the fast and slow
windings as used in the other methods or intermittent operation can be used
to wipe less frequently.

The control switches can be low current types since they only connect to PDM
inputs.

Solenoids

The current drawn by a normal single coil solenoid ramps up from zero to its
steady state value over a period of time. The time taken to do this depends on
the inductance and resistance of the solenoid but is normally very short (less
than 0.1 second). This has no affect on the PDM.

A solenoid will generate a voltage spike when turned off; this is clamped and
absorbed by the PDM. The amount of energy absorbed by the PDM depends
on the inductance and current in the solenoid. The PDM is capable of
absorbing the energy of most normal solenoids in a vehicle.
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Two Stage Solenoids

Some solenoids have two windings; one is used to turn the solenoid on, the
other is used to hold it on once it has switched. This ensures optimum turn on
characteristics with minimum holding current.

The current drawn by the turn on winding may be higher than the current
drawn by the holding winding. Ensure the Output Load is well clear of 100%
during turn on and during holding.

Starter Solenoids

In many cases it is possible to run starter solenoids from a single 20 Amp
output even though they typically draw more than 20 ampere (possibly as
much as 40 ampere).

The Over-Current Shutdown feature allows excess current for a period of
time. This feature will shut down the output after about 10 to 20 seconds of
cranking. See the Over-Current Shutdown section for details.

The wire can be rated for 20 ampere, also ensuring that the starter motor
does not overheat during excess cranking. A larger wire gauge might be
required if the voltage drop is not acceptable.

Alternatively two 20 Amp outputs may be paralleled allowing cranking for any
period of time (subject to overheating of the starter motor).

Electronic Devices

The PDM can supply power to electronic devices such as engine
management systems, data acquisition systems, radios etc.

Many electronic devices will have a short inrush current. The PDM will largely
ignore this due to the Output Load filtering. See the Over-Current Shutdown
section for details.

The PDM provides reverse battery protection and load dump clamping to
protect itself and the connected devices.

Ignition Systems

Inductive Ignition Systems

Most inductive ignition systems draw a peak current of about 8 ampere,
some draw as much as 20 ampere; however the average current is much
lower.

In most cases inductive ignition systems can be connected to an 8 Amp
output however the Output Load current must be checked to ensure it
stays well clear of 100%.
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The average current will increase with increasing RPM so the Output Load
should be checked at maximum RPM.

CDI Ignition Systems

CDI ignition systems can draw peak currents of as much as 50 ampere. It
Is recommended that all CDI ignition systems are connected to a 20 Amp
output.

The average current will increase with increasing RPM so the Output Load
should be checked at maximum RPM.

Engine Management Systems

The current drawn by an engine management system will depend on the type
of loads it is connected to and the operating conditions.

Fuel injectors draw current in pulses. The maximum average current drawn by
the fuel injectors is when they are at maximum duty cycle.

For servo devices such as Drive by Wire motors maximum current is drawn
when making large transitions.

Check that the Output Load is clear of 100% under worst case operating
conditions, i.e. when the injectors are operating at maximum duty cycle, servo
devices are making large transitions and any auxiliary loads are drawing
maximum current.

PDM Manager Software Installation

The PDM Manager software is used to:
e Change the PDM configuration

e Monitor the PDM operation including the output currents and
diagnostics

e Test the outputs by manually turning them off and on
e Set and unlock security password
e Update the firmware

PC Requirements

PDM Manager runs under Windows XP or Vista operating systems. The
minimum recommended PC specification is a Pentium 90 with 16 MB RAM
and a USB port.
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Installing PDM Manager Software

e Go to the MoTeC website at www.motec.com and navigate to
downloads/software/latestreleases/PDM Manager software
OR Locate PDM Manager software on the MoTeC Resource Disc

e Save the selected file in your preferred location (for example desktop)
¢ When downloading is finished, double click on the file and select run
e Follow the instructions on the InstallShield Wizard

e To start the program after installation, click
Start > All Programs > MoTeC > PDM Manager

Updating PDM Manager Software

Software updates are available to give access to the latest features.
Download the latest software version from the website and follow the software
installation instructions to update to the new version.

To update the associated firmware in the device select Update Firmware from
the Online menu. For more information refer to Operation.

Connecting the PDM to a PC
The PC communicates with the PDM via the CAN bus.

To connect the PC to the CAN bus, a mating connector for MoTeC's UTC
(USB to CAN adaptor) must be wired to the PDM CAN port.

If there are no other CAN devices connected refer to PC Connection Wiring
otherwise refer to CAN Bus Wiring Requirements.

Note: MoTeC's CAN cable cannot be used with the PDM.
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Configuration

The PDM requires various settings to be configured such as the maximum
current settings for the outputs and the circumstances in which to turn the
outputs on.

The configuration settings are stored in a configuration file on the PC.

Changes to the PDM configuration are performed ‘Offline’, i.e. without the PC
communicating with the PDM. The changes are saved in the configuration file
on the PC. The file must be sent to the PDM before the changes take effect.
See Operation.

Configuration File

From the File menu the following options are available:
e New: creates a new configuration file

e Open: selects an existing configuration file
Right-click the configuration file to Rename, Delete, Send to a disk etc.

e Close: closes the current configuration file

e Save: after a new configuration has been defined, it should be saved with
a meaningful name

e Save as: can be used to create a copy of an existing configuration file by
giving it a new name

e Check Channels: verifies that all channels are correctly generated
e Exit: exits the program

To create a new configuration file

e On the File menu, click New.
e Select the PDM type and enter the Serial Number
The serial number can be found on the PDM label
This will open the Configuration Tree panel and the Channels panel.

Tips:
e The most recently used files appear at the bottom of the File menu.
This is often the easiest way to open an existing file.

e When changing the PDM type all configured inputs and outputs settings
will be transferred to the relevant pin number in the new PDM type.

e Configuration files can be password protected, preventing unauthorised
retrieving and sending of configuration files.
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Channels

Channels are used to link the various systems within the PDM configuration.

For example: The input pin system generates two channels for each
configured input pin. Depending on the state of the input pin the input channel
value will be zero or one.

The channel can be selected to directly control a particular output. It can also
be used as an input to a Condition. This is a complex logic function that
combines a number of channels to create a new channel. This new channel
can then be used to control an output, or as an input to another condition.

Each channel can only be generated once, but may be used by multiple
outputs and conditions.

Channel Names

Each channel has a hame to identify it. By including a dot between parts of
the channel name, channels are arranged in a tree structure.

For example: Indicators.Left and Indicators.Right would appear as Left and
Right under a node called Indicators.

Search:

=& Indicators
+ -0 | eft
+- 010 Right
- | &| POM

- &] CAN Inputs

+-000 CARN Tirneout

- & Constants
0l Global Error

+ ﬂ Input Yoltages
ol [rternal WE
0l Temperature
oL Tatal Current

LF. | | Cancel

The use of a dot between parts of the channel name is optional. The channel
list will be a simple flat list rather than a tree structure if it is not used.
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To rename a channel globally

¢ Right-click on the channel name in the Channels window and click
Rename.
This will rename the channel where it is generated as well as in all the
places where it is used.

Configuration Tree

The Configuration Tree is used to configure the Global Setup, Input Pins,
CAN Inputs, Conditions and Output Pins.

The input and output pins will be numbered according to the PDM type
selected.

Global Setup

The Global Setup in the configuration tree is used to
e Enter the PDM type and serial number
e Setthe base CAN address for incoming CAN communication
e Enable outgoing CAN messages and set their base address
e Set a Master Retry for all output pins

Master Retry

The Master Retry feature turns all outputs that are in error back on. If there is
still a fault on a particular output, this output will go into error again and will go
through the normal retry sequence.

To initiate a Master Retry by pressing a button
e Wire a button to a switch input

e Use the channel generated by this input as the trigger channel for the
Master Retry.

Input Pins

Configuration of an input will create a Status and a Voltage channel. Both
channels can be used in a condition or to directly control an output. They are
transmitted via CAN.

To configure an Input Pin

e In the Configuration Tree, select Input Pins

e Double click the input to setup

e Type a channel name and select settings as required
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The trigger voltages are fully programmable. The recommended trigger
voltages are approximately 3.5 V for the low threshold and 4.2 V for the high
threshold. The high threshold should be set below 6 V to ensure detection of a
high level signal when the battery voltage is low.

To avoid switch bounce and/or to delay recognition when the switch changes
state, the inputs also have programmable trigger times. A trigger time of 0.1
second will normally reject switch bounce.

Channel Name Description CAN Output
InputName Input Status Yes
0 = Off
1=0n
InputName.Voltage Voltage on the input Yes
Resolution 0.2 V

CAN Inputs

The PDM can receive CAN messages allowing the outputs to be controlled by
other devices.

The PDM receives CAN messages on any of four sequential CAN IDs. The
IDs must be within the standard address range. The base CAN address is
selected in Global Setup in the Configuration Tree.

The CAN communication rate of the PDM is 1 Mbit/sec. The communication
rate in other devices must be set to the same speed.

Channels are extracted from the CAN messages by specifying a CAN
address and an offset. The offset determines which byte in the message is
used as the channel value.

Each CAN generated channel will be set to zero on start-up and stay zero
until a matching CAN message is received.

If any of the CAN messages is not received for 1 second, the corresponding
timeout channel will be set to TRUE. During the CAN timeout period the
channel value remains at the last received value.

Tip: The timeout channel can be used in a condition.

8 Bit Values

The PDM can receive 8 bit values, which can be used directly or masked with
a bit mask.

16 Bit Values

The PDM may receive 16 bit signed values. A divide factor must be specified
to reduce the value to fit into the 8 bit result channel which has a range of 0 to
255 (unsigned).
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For example, a 16 bit RPM value with resolution of 1 RPM could be divided by
100 to give a value with a resolution of 100 RPM. The maximum channel
value of 255 will be equivalent to 25500 RPM.

If the value after division is greater than 255 then the result value will be
clamped to 255. The PDM treats the received value as a signed 16 bit value
(i.e. -32768 to 32767). Negative values are clamped to 0.

To configure a CAN input

¢ In the Configuration Tree, select CAN Inputs

e On the Edit menu, click Add

e Type a channel name and select settings as required

CAN Output

A fixed set of messages can be sent from the PDM via CAN to other devices.
CAN outputs are enabled via Global Setup.

Most MoTeC logging devices have CAN communications templates available
to receive these messages. The CAN communication rate of the PDM is

1 Mbit/sec. The communication rate in other devices must be set to the same
speed as in the PDM.

The transmitted CAN messages include Output Voltage, Output Current,
Output Load, Output Status, Input State, Internal Temperature, Battery
Voltage, Global Error, and Total Current. See Fuse Characteristics for details.

The receiving device can use the messages for diagnostic purposes
(particularly useful if the values are logged in a logging device), to show an
alarm on a display or to activate a feature in another device depending on the
value of a PDM input switch.

Conditions

A condition is a complex logic function that combines a number of channels to
create a new channel. The logic operations include AND, OR, flash and many
more.

The new channel, with a value of either TRUE (1) or FALSE (0), can be used
to directly control an output or it can be used in another condition.

Number of Operations

There is a total of 200 logic operations available in the PDM. The number of
operations used is shown in the status line.

Tip: A condition can also be configured in the output pin setup. In this case
the outcome of the logic function will not create a new channel but will be
directly connected to the output channel.
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To configure a Condition

¢ In the Configuration Tree, select Conditions

e On the Edit menu, click Add

e Type a channel name and select settings as required

Output Pins

All outputs are high side type outputs; they switch Batt+ to the output pin. All
outputs have hardware thermal overload protection, fault logic and over-
current logic.

Paralleled Outputs

When two or more output pins are connected in parallel, they must be
configured to use a common channel or an identical condition to activate
them.

Note: outputs that are connected in parallel must all be of the same type;
either all 8 Amp or all 20 Amp outputs.

Output Protection

Over-Current Shutdown

An Over-Current Shutdown occurs when the Output Load exceeds 100%,
which corresponds to the maximum current setting.

The Output Load value is filtered so that it normally increases (and
decreases) slowly, modelling how the temperature of a wire responds to
the current flowing through it. The resultant characteristic is very similar to
a thermal circuit breaker which is often used in motorsport applications. It
is also similar to a slow blow fuse. See Fuse Characteristics for details.

The filtering of the load value ensures that the start-up current (inrush
current) of motors and lamps does not cause the output to shutdown
during this period. It also allows for short term overloads to occur without
the output shutting down.

A large over-current such as a short circuit will cause the Output Load
value to increase rapidly, causing the output to shutdown in a short period
of time to protect the wire and the PDM output. The filtering is set with a
time constant of 20 to 50 seconds based on the maximum current setting.
These values conservatively suit the appropriate wire gauge for the
selected current setting and are not adjustable.

Tips:
e The Output Load and Output Current values are transmitted via CAN so
that they can be logged by another device. Check the logged Output
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Load value to ensure it is not too close to 100% during normal
operation and during start-up.

e The Output Load and Output Current values can also be monitored
using PDM Manager. See Checking Operation.

Fault Shutdown

A Fault Shutdown occurs when the output voltage is lower than expected.
This can be caused by a short circuit or thermal overload of the output.

A short circuit may cause a Fault Shutdown before the Over-Current
Shutdown occurs.

Output Settings

To configure an Output Pin

¢ In the Configuration Tree, select Output Pins

e Double click the output to setup

e Type a channel name and select settings as required

Maximum Current

This sets the current at which the output will shutdown. The output current
may exceed this value for a period of time which allows for the start-up
(inrush) current of devices such as motors and lamps.

The maximum current can be set to 10 ampere on the 8 Amp outputs and
25 ampere on the 20 Amp outputs to be clear of the normal running
current, even for devices that draw the maximum specified current of 8 or
20 ampere.

Number of Retries and Retry Delay

When an Over-Current Shutdown or a Fault Shutdown occurs, the PDM
will attempt to turn the output on again if the Number of Retries is
configured. The Number of Retries determines how many times an output
will attempt to turn on again.

The Retry Delay determines how long an output remains shutdown before
it is turned on again.

The retry count for an output is reset whenever the condition driving the
output changes to FALSE and then to TRUE (i.e. when the condition
driving the output turns off then on again).

Tips:
e There is a Master Retry feature available in Global Setup
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Ensure that the maximum current has been set appropriately by
checking that the Output Load value is less than 100% under all
operating conditions.

The wire used must be capable of carrying the current specified in the
maximum current setting. See Wire Specification.

Set the maximum current well clear of the normal operating current of
the device but within the current rating of the wire. Use a larger wire to
achieve this if necessary. For example, for a device that draws no more
than 5 ampere (except at start-up) use a wire that is rated at 8 ampere

and set the maximum current to 8 ampere to give a clear margin.

e Consider the voltage drop of the wire when selecting the wire size.
Sometimes this dictates that a larger wire gauge is needed than the
current rating would suggest.

e Setting the current close to the normal current of the device to try and
protect the device is unlikely to be effective and could result in an
inadvertent shutdown. The purpose of the maximum current setting is
to protect the wire from overheating, not to protect the connected

device.

e Some devices draw more current under circumstances such as high or
low battery voltage. Also, a motor will draw increased current when
under more load. Set a good margin and where possible check the
Output Load value under these varying circumstances.

Configuration of an output will create a number of channels, some of which
are transmitted via CAN. OutputName.Status channel is used for output
status information on CAN. The output should be on for any non-zero value.

Channel Name

Description

CAN
Output

OutputName

Output Control Status

0 = Off

1 = On (Note: the output may be off
due to Over-current Shutdown or
Fault Shutdown)

No

OutputName.Voltage

Voltage on the output
Resolution 0.2 V

Yes

OutputName.Current

Output Current in amps
Resolution 0.5 A on Outputs 1 — 8
Resolution 0.2 A on Outputs 9 — 32

Yes

OutputName.Load

Output Load. Filtered current as a
percentage of the maximum current
setting.

Yes
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Channel Name Description CAN
Output
Resolution 1%
OutputName.Status 0 = Off Yes
1 = On Active

2 = Over-Current Shutdown
4 = Fault Shutdown

OutputName.Status. | 0 = Output is off No
Active 1 = Output is on

OutputName.Status. | 0 = OK No
OverCurrent 1 = Over-Current Shutdown
OutputName.Status. | 0 = OK No
Fault 1 = Fault Shutdown

Fault Indicator

When an output fault occurs the PDM sets the value of the Global Error
channel to TRUE (PDM.Global Error). A fault indicator light can be connected
to any PDM output and configured to turn on when the Global Error channel is
TRUE.

The Global Error channel can also be transmitted via CAN to a display device
and used to show an alarm message and activate an alarm light.

Maximum Current for Typical Output Devices

Lamps
e Tungsten Lamps
Typically used for tail lights, indicator lights and general lighting.

Tungsten lamps draw additional current during turn on. Typically this
peaks at about 5 times the steady state current and dies out in about 0.1
second. The PDM will largely ignore this due to the Output Load filtering.

e Halogen Lamps

Halogen lamps are commonly used in headlights and are more efficient
than Tungsten lamps.

Halogen lamps have similar characteristics to Tungsten lamps.
e Xenon (HID) Lamps

Xenon lamps are also used in headlights and are more efficient than
Tungsten and Halogen lamps.

Xenon lamps have a long duration inrush current that peaks at about 4
times the steady state current. The inrush current decays over a period of
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about 10 seconds. This puts a high load on the PDM output during start-
up.
To avoid Over-Current Shutdown during start-up it may be necessary to

set a higher Maximum Current than normal particularly if the battery
voltage is low.

For example, a Xenon lamp with a steady state current of 3 ampere may
need a Maximum Current setting of 6 to 8 ampere. The wire should also
be rated at this current.

Unlike other lamps, Xenon lamps draw more current as the battery voltage
decreases. At 10 volt the lamp will draw 40% more current than at 14 volt.
For example a lamp that draws 3 ampere at 14 volt will draw 4.2 ampere at
10 volt. This must be allowed for when setting the Maximum Current.

To ensure that the Maximum Current is set appropriately, check that the
Output Load value stays safely below 100% during turn on when the
battery is at 12 volt (not charging).

Motors

Electric motors draw additional current during start-up. Typically the start-
up current is 3 to 5 times the steady state current and it dies out in less
than a second.

This start-up current is largely ignored by the PDM due to the Output Load
filtering.

The current in a motor increases with increasing load on the motor. A
motor draws maximum current when it is stalled. The Maximum Current
setting should take this into account.

A motor may draw more current as it or the device that it is connected to
ages; this should be allowed for when setting the Maximum Current.

Note: motor speed control is currently not supported.
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Operation

CAUTION: The PDM may get very hot, do not touch the PDM during
operation.

To perform any of the activities in the Online menu, the PC needs to
communicate with the PDM.

When a configuration file is open in PDM Manager, it will connect to the PDM
with the matching serial number.

If there is no file open, all connected PDMs will be displayed. PDM Manager
can be connected to a selected PDM.

Sending and Retrieving Configuration Files

¢ On the Online menu, click Send Configuration to send the currently
open configuration file to the connected PDM

e On the Online menu, click Get Configuration to retrieve the current
configuration file in the connected PDM

Checking Operation

Monitor Channels

e On the Online menu, click Monitor Channels

Monitor Channels shows the value of each channel in the original tree
structure.

Monitor PDM

e On the Online menu, click Monitor PDM

Monitor PDM shows the input-, output-, CAN input-, condition- and PDM
status channels in separate screen areas in an easy to view layout.

Test Outputs

e On the Online menu, click Test Outputs

All outputs may be manually turned on and off in PDM Manager to check the
current levels.

To be able to test an output, it must first be configured in PDM Manager.
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Serial Number

e On the Online menu, click Show Serial Number

A configuration file can only be sent to the PDM with the matching serial
number.

This allows multiple PDMs to be used without special device configuration
requirements and also ensures that each PDM has the correct configuration
file.

Firmware Versions and Updating

¢ On the Online menu, click Update Firmware

The software inside the PDM (firmware) can be updated by the user at any
time to take advantage of the latest features.

Matching Versions

The firmware version must match the version of the PDM Manager software
on the PC in order to communicate. PDM Manager will show a warning if the
versions do not match.
Tip:
To check the version of PDM Manager software, click About MoTeC PDM
Manager on the Help menu.
To check the firmware version in the PDM click Show Serial Number on
the Online menu

Matching Configuration File

Configuration files created with new software including new features can
not be used with older version of the software. If required, create backup
files before updating.

Password Protection

e On the Online menu, click Set Password

The password will prevent unauthorised retrieving and sending of
configuration files.

It is not possible to update firmware if the PDM is password protected.

Standby Mode

The PDM enters a low current Standby Mode when all outputs are off and
there is no CAN activity. The PDM exits Standby Mode when the state of any
input changes or CAN activity resumes.
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Specifications

General

Battery voltage

30V max, 6.5V min

Current consumption

35 mA typical operating
5 mA typical standby

Total output current
(continuous)

PDM16 PDM32 | PDM15 | PDM30

100 A 120 A 80 A 100 A

Reverse battery
protection

Protection for PDM and all connected devices

Load dump transient
protection

Protection for PDM.
Also assists in protecting connected devices.

Operating temperature

110 °C max internal (100 °C recommended)
Typical 85 °C max ambient for 120 A total load (for
110 °C internal) depending on mounting, air
circulation and load distribution.

These specifications apply for a 12 V battery.

For a 24 V battery reduce specified temperatures
by 20 °C.

Weight PDM16 PDM32 PDM15 PDM30
33049 405 g 260 g 270 g
(0.721bs) | (0.89 Ibs) (0.57 Ibs) | (0.59 Ibs)
Length 130 mm 180 mm 107 mm 107 mm
(5.1" (7.1 (4.2 4.2")
Width 60 mm 60 mm 133 mm 133 mm
(2.4 (2.4 (5.2") (5.2")
Height 28 mm 28 mm 39 mm 39 mm
(1.1 (1.1 (1.5 (1.5")
Case Machined aluminium Magnesium
Environmental Rubber seal on lid and Conformal coating on
protection connectors, conformal PCB
coating on PCB
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20 Amp Outputs
Number of 20 A outputs PDM16 PDM32 PDM15 | PDM30
8 8 8 8

Maximum output current

20 A continuous, 115 A transient (typical)

Over-current shutdown

Programmable in steps of 1 A

Protection

Short circuit and thermal overload
protection

Inductive load clamp voltage

—17 V (relative to Batt—)

Maximum inductive load
energy

1.5 J (junction temperature = 150 °C, load
current = 20 A)

8 Amp Outputs

Number of 8 A outputs

PDM16

PDM32

PDM15

PDM30

8

24

7

22

Maximum output current

8 A continuous, 60 A transient (typical)

Over-current shutdown

Programmable in steps of 1 A

Protection

Short circuit and thermal overload
protection

Inductive load clamp voltage

Output 9: 0.7 V (relative to Batt-)
Other Outputs: —42 V (relative to Batt+)

Maximum inductive load
energy

0.3 J (junction temperature = 150 °C, load
current = 20 A)

Inputs

Number of inputs

PDM16

PDM32

PDM15

PDM30

12

23

16

16

Pull-up resistor

10 kilo ohm to Batt+

Measurement Range of 0 to 51 V, resolution 0.2 V
(8 bits)
Calibration High and low trigger voltage, high and low
trigger times
CAN Input

Number of messages

4 messages, 8 bytes per message

CAN OQOutput

Message rate

20 Hz
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Fuse Characteristics

Trip time versus over current multiplier at 10A
100.00
Trip time
(s)

10.00
1.00

010 T T T T

1 2 3 4 5 6 7 8

Over current multiplier

Max current setting [A] | Trip time multiplier
4 76%
6 84%
8 92%
10 100%
15 120%
20 140%

Example:
For 25 A current where max current setting is 5 A:

Over current multiplier: 25 A/5A =5

From Graph: Trip time (at 10 A) is approx 1 second
From Table: Trip time multiplier (at 5 A) is approx 80%
Trip time (at 5 A) = 1 x 80% = 0.8 seconds
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Connectors and Pinout

PDM16

Connector A

Connector B

26 pin Autosport
Mating connector #65040

1 pin Autosport

Mating connector
#68093 (wire gauge #6 AWG)
#68094 (wire gauge #4 AWG)

Pin Function

Pin Function

A_A 8 A Output 9

B 1 Batt+

A_B 8 A Output 10

A_C 8 A Output 11

A D Digital/Switch Input 1

Connector C

A E Digital/Switch Input 2

8 Pin Autosport

A F Digital/Switch Input 3 Mating Plug: Deutsch AS616-08SN
A G oV Pin Function

A H ov CA 20 A Output 1

Al CAN Low CB 20 A Output 2

A K CAN High Cc_C 20 A Output 3

AL 8 A Output 12 C D 20 A Output 4

A M 8 A Output 13 CE 20 A Output 5

AN 8 A Output 14 CF 20 A Output 6

A P 8 A Output 15 CG 20 A Output 7

A R 8 A Output 16 CH 20 A Output 8

A_S Digital/Switch Input 4

AT Digital/Switch Input 5

A U Digital/Switch Input 6

AV Digital/Switch Input 7

AW Digital/Switch Input 8

A_X Digital/Switch Input 9

ALY Digital/Switch Input 10

AZ Digital/Switch Input 11

A a Digital/Switch Input 12

A Db Batt—

A c Batt—
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PDM32

Connector A

Connector B

37 pin Autosport
Mating connector #68089

26 pin Autosport

Mating connector #65040

Pin Function Pin Function
A1l Digital/Switch Input 1 B_A 8 A Output 9
A 2 Digital/Switch Input 2 B B 8 A Output 10
A 3 Digital/Switch Input 3 B C 8 A Output 11
A 4 Digital/Switch Input 4 B D 8 A Output 12
A5 Digital/Switch Input 5 B_E 8 A Output 13
A 6 ovVv B F 8 A Output 14
A7 oV B G 8 A Output 15
A 8 oV B_H 8 A Output 16
A9 oV B J 8 A Output 17
A 10 CAN Low B_K 8 A Output 18
A 11 CAN High B L 8 A Output 19
A 12 Digital/Switch Input 6 B M 8 A Output 20
A_13 Digital/Switch Input 7 B_N 8 A Output 21
A_14 Digital/Switch Input 8 B_P 8 A Output 22
A 15 Digital/Switch Input 9 B R 8 A Output 23
A 16 Digital/Switch Input 10 B S 8 A Output 24
A 17 Digital/Switch Input 11 BT 8 A Output 25
A 18 Digital/Switch Input 12 B U 8 A Output 26
A_19 Digital/Switch Input 13 B_V 8 A Output 27
A_20 Digital/Switch Input 14 B_W | 8 AOutput 28
A 21 Digital/Switch Input 15 B X 8 A Output 29
A 22 oV B_Y 8 A Output 30
A 23 ov B Z 8 A Output 31
A 24 ov B a 8 A Output 32
A 25 oV B b Batt—

A_26 Digital/Switch Input 16 B c Batt—

A 27 Digital/Switch Input 17

A 28 Digital/Switch Input 18

A 29 Digital/Switch Input 19

A 30 Digital/Switch Input 20

A_31 Digital/Switch Input 21

A_32 Digital/Switch Input 22

A 33 Digital/Switch Input 23

A 34 Not Connected

A 35 Not Connected

A_36 Not Connected

Not Connected
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PDM32 continued

Connector C

1 pin Autosport
Mating connector

#68093 (wire gauge #6 AWG)
#68094 (wire gauge #4 AWG)

Pin

Function

C.1

Batt+

Connector D

8 pin Autosport
Mating connector #68092

Pin

Function

D A

20 A Output 1

20 A Output 2

20 A Output 3

20 A Output 4

20 A Output 5

20 A Output 6

20 A Output 7

20 A Output 8
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PDM15

Connector A

Connector B

34 pin waterproof connector
Mating connector #65044

26 pin waterproof connector
Mating connector #65045

Pin Function Pin Function
Al 20 A Output 1 (with A10) B 1 Not used
. 8 A Output 9 B Not used

20 A Output 2 (with A12)

20 A Output 6 (with B9)

AWIN

8 A Output 10

AIWIN

Not used

20 A Output 3 (with A14)

20 A Output 7 (with B11)

8 A Output 11

Not used

20 A Output 4 (with A16)

20 A Output 8 (with B13)

8 A Output 12

Not used

20 A Output 5 (with A17)

20 A Output 6 (with B3)

20 A Output 1 (with Al)

Not used

8 A Output 13

20 A Output 7 (with B5)

20 A Output 2 (with A3)

Not used

8 A Output 14

20 A Output 8 (with B7)

20 A Output 3 (with A5)

Not used

8 A Output 15

Digital/Switch Input 13

20 A Output 4 (with A7)

Not used

20 A Output 5 (with A9)

Digital/Switch Input 15

Not used

Battery Negative

Digital/Switch Input 2

Not used

Not used

Digital/Switch Input 11

Digital/Switch Input 4

Digital/Switch Input 12

Not used

oV

Digital/Switch Input 7

Digital/Switch Input 14

Not used

Digital/Switch Input 16

Not used

CAN Low

Battery Negative

0|00|00|00|00|00|00100|00|100|00|00|00(00(00(00(00(00(C0(C0|(C0|00|00|00| 00
NN (R (R(RRR[RrR[RrR[2[O[o|N[o|ugn

OO IWINIRPO(O(O|INO|OIAR(WIN|IF|O

CAN High

Digital/Switch Input 1

oV

OO INO(O|AR|IWIN|FP|IO|O(0|N|O|OTAWIN(FR|O

Digital/Switch Input 3

o

Digital/Switch Input 5

Connector C

> > > |3 >|> > >>|>|>> > >|> | >>>|>|>>>>|>|>>>| > > > > > >

WIWIWIWIWININININININININDINDINIPIP(RPIPIRPIP(PIPIP(RPR[O|O[N[O|0]

31 Digital/Switch Input 6 M6 stud

32 Digital/Switch Input 8 Mating: eyelet and M6 nut
33 Digital/Switch Input 9 Pin Function

34 Digital/Switch Input 10 C1 Battery +
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PDM30

Connector A

Connector B

34 pin waterproof connector
Mating connector #65044

26 pin waterproof connector
Mating connector #65045

Pin Function Pin Function

Al 20 A Output 1 (with A10) B 1 8 A Output 21

A2 8 A Output 9 B 2 8 A Output 22

A 3 20 A Output 2 (with A12) B-3 20 A Output 6 (with B9)
A4 8 A Output 10 B 4 8 A Output 23

A5 20 A Output 3 (with A14) B-5 20 A Output 7 (with B11)
A 6 8 A Output 11 B 6 8 A Output 24

A7 20 A Output 4 (with A16) B 7 20 A Output 8 (with B13)
A 8 8 A Output 12 B 8 8 A Output 25

A9 20 A Output 5 (with A17) B 9 20 A Output 6 (with B3)
A 10 20 A Output 1 (with A1) B 10 8 A Output 26

A 1ll 8 A Output 13 B 11 20 A Output 7 (with B5)
A 12 20 A Output 2 (with A3) B 12 8 A Output 27

A 13 8 A Output 14 B 13 20 A Output 8 (with B7)
A 14 20 A Output 3 (with A5) B 14 8 A Output 28

A 15 8 A Output 15 B 15 Digital/Switch Input 13
A 16 20 A Output 4 (with A7) B 16 8 A Output 29

A 17 20 A Output 5 (with A9) B 17 Digital/Switch Input 15
A 18 8 A Output 16 B 18 Battery Negative

A 19 Digital/Switch Input 2 B 19 8 A Output 30

A 20 8 A Output 17 B 20 Digital/Switch Input 11
A 21 Digital/Switch Input 4 B 21 Digital/Switch Input 12
A 22 8 A Output 18 B 22 oV

A 23 Digital/Switch Input 7 B 23 Digital/Switch Input 14
A 24 8 A Output 19 B 24 Digital/Switch Input 16
A 25 8 A Output 20 B 25 CAN Low

A 26 Battery Negative B 26 CAN High

A 27 Digital/Switch Input 1

A 28 oV

A_29 Digital/Switch Input 3

A 30 Digital/Switch Input 5 Connector C

A 31 Digital/Switch Input 6 M6 stud

A_32 Digital/Switch Input 8 Mating: eyelet and M6 nut

A 33 Digital/Switch Input 9 Pin Function

A 34 Digital/Switch Input 10 C1 Battery +
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Mounting Dimensions
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MoTeC

PDM32
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PDM15 and PDM30

Cover power stud with
insulating cap
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Wiring

Wire Specification

M22759/16

Insulation Material: Tefzel
Conductor: Tin Plated Copper
Voltage Rating: 600 V
Maximum Temperature: 150 °C

Wire |Current Rating |Current Rating Resistance | Resistance

Gauge |at 80 °C ambient |at 100 °C ambient |[ohm/m] [ohm/1000 ft]

(AWG) [A]* [A]*
24+# 4.5 4 0.071 22
22# 6 5 0.045 14
20# 8 6 0.028 8.5
18# 11 9 0.018 5.5
16# 15 12 0.014 4.3
14# 22 18 0.009 2.7
64 90% 75% 0.0015 0.44
44 120%F 100% 0.0009 0.28
2# 150%F 120F 0.0006 0.18

*The current ratings above are an indication only and will not apply in all
circumstances.

The actual maximum current rating is determined by the maximum allowed
temperature for the wire (150 °C).

The temperature of the wire is affected by many factors including the
temperature of adjacent wires, how the wires are bundled and covered, the
ambient temperature and the current.

Fcurrent rating for a single wire in free air

Recommended Wire Gauge Output

24+ to 20# 8 Amp outputs
20# to 16# 20 Amp outputs
4# 1o 2# Battery pos
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PC Connection Wiring
The PDM connects to the USB port on the PC. This requires a CAN connector
in the loom for MoTeC's UTC (USB to CAN adaptor and USB cable).

If the PDM does not connect to any other CAN device, it can be directly wired
to the CAN connector.

If the wiring length is less than 2 m (7 ft) the terminating resistor is
recommended but not essential.

CAN Connector PDM
1 Black 9
> oV
3
4 Green Green 10 CAN-LO
5 White f White 11 CAN-HI

These wires must be twisted
Minimum one twist per 50 mm (2 in)

100R Resistor
*Not essential if the wiring
length is less than 2 m (7 ft)

UTC Connector Type:
Deltron  716-0-0501 (Non-latching)
Neutrik  NC5FDL1 (Latching)

CAN Bus Wiring Requirements

The CAN bus should consist of a twisted pair trunk with 100R (0.25 watt)
terminating resistors at each end of the trunk.

The preferred cable for the trunk is 100R data cable but twisted 22# Tefzel is
usually OK.

The maximum length of the bus is 16 m (50 ft)

CAN devices (such as MoTeC PDM, M800 etc) may be connected to the
trunk with up to 500 mm (20 in) of twisted wire.

The CAN Connector for the UTC may also be connected to the trunk with up
to 500mm (20in) of twisted wire and should be within 500mm of one end of
the trunk. If desired two CAN connectors may be used so that the UTC may
be connected to either side of the vehicle. Both connectors must be within
500mm of each end of the trunk.
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100R Terminati CAN
Resisto?srrgltnSalgk? These wires must be twisted Connector
end of the CAN Bus Minimum one twist per 50 mm (2 in) < =
/ 500 mm 9
<< CAN Bus >> e 4%
gl y =
= - ® Py
9
E
39 _ | 3
CAN Device CAN Device || CAN Device
eg ADL2 eg M800 eg PDM

Short CAN Bus

If the CAN Bus is less than 2 m (7 ft) long then a single termination resistor
may be used. The resistor should be placed at the opposite end of the CAN
bus to the CAN connector.
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CAN Output Messages

The PDM transmits the following messages at 20 Hz.

Note: only relevant messages get transmitted

CANID Byte [Bit |[Channel Scaling
0 4.7 |CompoundId=0
0 0 Input 1 State
1 0 Input 2 State
2 0 Input 3 State
Baseld+0 |3 0 Input 4 State 0 = Inactive
4 0 Input 5 State 1 = Active
5 0 Input 6 State
6 0 Input 7 State
7 0 Input 8 State
0 4.7 |Compoundld=1
0 0 Input 9 State
1 0 Input 10 State
2 0 Input 11 State
Baseld+0 |3 0 Input 12 State 0 = Inactive
4 0 Input 13 State 1 = Active
5 0 Input 14 State
6 0 Input 15 State
7 0 Input 16 State
0 4..7 |Compound Id =2
0 0 Input 17 State
1 0 Input 18 State
Base ld + 0 2 0 Input 19 State 0 = Inactive
3 0 Input 20 State 1 = Active
4 0 Input 21 State
5 0 Input 22 State
6 0 Input 23 State
0 4..7 |CompoundId =3
PDM Internal 0to125=0°C to +125°C
1 0..7 0
Temperature 1 °C steps
O0to255=0Vto31V
2 0..7 | PDM Battery Voltage 0.1216 V steps
0=0K
3 0..7 |Global Error Flag 1 = one or more outputs is in
Base Ild + 0 either Fault or Over-Current error
4 0..7 |Total Current 010255=010255 A
1 A steps
0to255=0Vto 15.68V
5 0.7 9.5V internal rall 0.0615 V steps
" voltage Should read close to 9.5 V when
the Battery voltage is > 10.5V
6 0..7 |Reset Source
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CANID

Byte

o8]
=

Channel

Scaling

Baseld +1

Compound Id=0

Output 1 Current

Output 2 Current

Output 3 Current

Output 4 Current

Output 5 Current

Output 6 Current

Output 7 Current

0to255=0to 127.5A
0.5 A steps

Baseld +1

Compound Id =1

Output 8 Current

0to255=0to0 127.5A
0.5 A steps

Output 9 Current

Output 10 Current

Output 11 Current

Output 12 Current

Output 13 Current

Output 14 Current

Oto255=0to 51 A
0.2 A steps

Baseld +1

Compound Id = 2

Output 15 Current

Output 16 Current

Output 17 Current

Output 18 Current

Output 19 Current

Output 20 Current

Output 21 Current

0to255=0to 51 A
0.2 A steps

Baseld +1

Compound Id =3

Output 22 Current

Output 23 Current

Output 24 Current

Output 25 Current

Output 26 Current

Output 27 Current

Output 28 Current

0t0255=0to51 A
0.2 A steps

Baseld +1

Compound Id =4

Output 29 Current

Output 30 Current

Output 31 Current

AWINFRPOINO|O|RAR|WIN|PRP|IONOO|PAWINRP|IOINO|IORAR|IWIN] P ([O|NO|OIA|W|IN[FR|O

olo|olo|olo|olo|olo|olo|o|o|olo|o|o|olo|o|o|ololo]e|o] o |o]o|o|olo|e|o|o|e
) 0 Y Y 0 0 0 0 0 0 0 0 0 0 0 0 ) 00 00 Y 0 00 Y Y Y

Output 32 Current

O0to255=0to 51 A
0.2 A steps
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CANID

Byte

o8]
=

Channel

Scaling

Base Id + 2

Compound Id=0

Output 1 Load

Output 2 Load

Output 3 Load

Output 4 Load

Output 5 Load

Output 6 Load

Output 7 Load

0 to 255 = 0 to 255%
1% steps

Base Id + 2

Compound id =1

Output 8 Load

Output 9 Load

Output 10 Load

Output 11 Load

Output 12 Load

Output 13 Load

Output 14 Load

0 to 255 = 0 to 255%
1% steps

Base Id + 2

Compound Id =2

Output 15 Load

Output 16 Load

Output 17 Load

Output 18 Load

Output 19 Load

Output 20 Load

Output 21 Load

0 to 255 = 0 to 255%
1% steps

Base Id + 2

Compound Id =3

Output 22 Load

Output 23 Load

Output 24 Load

Output 25 Load

Output 26 Load

Output 27 Load

Output 28 Load

0 to 255 = 0 to 255%
1% steps

Base Id + 2

Compound Id=4

Output 29 Load

Output 30 Load

Output 31 Load

AIWINIFPOINO|IO[RAR|WIN|IFP|ION|IO(OAR[WINIFPIOIN|O|OTAIWIN|IRPOINO|OIA[W|IN[F|O

o|o|olo|olo|o|o|o|olo|o|o|o|olo|o|o|o|ololo|o|o|e|o|o|olo]elolo|o|o|e]o]e
0 0 Y 0 0 Y 0 0 Y 0 0 Y ) 0 0 0 0 0 0 Y 0 0 Y 0 0 Y Y

Output 32 Load

0 to 255 =0 to 255%
1% steps
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CANID

Byte

o8]
=

Channel

Scaling

Baseld + 3

Compound Id=0

Output 1 Voltage

Output 2 Voltage

Output 3 Voltage

Output 4 Voltage

Output 5 Voltage

Output 6 Voltage

Output 7 Voltage

O0to255=0to 51V
0.2 V steps

Baseld + 3

Compound id =1

Output 8 Voltage

Output 9 Voltage

Output 10 Voltage

Output 11 Voltage

Output 12 Voltage

Output 13 Voltage

Output 14 Voltage

0to255=0to51V
0.2 V steps

Baseld + 3

Compound Id =2

Output 15 Voltage

Output 16 Voltage

Output 17 Voltage

Output 18 Voltage

Output 19 Voltage

Output 20 Voltage

Output 21 Voltage

O0to255=0to 51V
0.2 V steps

Baseld + 3

Compound Id =3

Output 22 Voltage

Output 23 Voltage

Output 24 Voltage

Output 25 Voltage

Output 26 Voltage

Output 27 Voltage

Output 28 Voltage

0to255=0to51V
0.2 V steps

Baseld + 3

Compound Id=4

Output 29 Voltage

Output 30 Voltage

Output 31 Voltage

AIWINIFPOINO|IO[RAR|WIN|IFP|ION|IO(OAR[WINIFPIOIN|O|OTAIWIN|IRPOINO|OIA[W|IN[F|O

o|o|olo|olo|o|o|o|olo|o|o|o|olo|o|o|o|o|olo|o|o]e|o|o|olo]elolo|o|o|e]o]e
0 0 Y 0 0 Y 0 0 0 0 Y 0 0 0 0 0 0 0 Y ) 0 0 Y 0 0 Y Y Y

Output 32 Voltage

Oto255=0to51V
0.2 V steps
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CANID

o8]
=

Byte Channel

Scaling

Base ld + 4

Compound Id=0

Output 1 Status

Output 2 Status

Output 3 Status

Output 4 Status

Output 5 Status

Output 6 Status

Output 7 Status

Output 8 Status

0 = Output off

1 = Output on

2 = Output Over-Current Error
4 = Output Fault Error

Baseld + 4

Compound id =1

Output 9 Status

Output 10 Status

Output 11 Status

Output 12 Status

Output 13 Status

Output 14 Status

Output 15 Status

Output 16 Status

0 = Output off

1 = Output on

2 = Output Over-Current Error
4 = Output Fault Error

Base ld + 4

Compound Id =2

Output 17 Status

Output 18 Status

Output 19 Status

Output 20 Status

Output 21 Status

Output 22 Status

Output 23 Status

Output 24 Status

0 = Output off

1 = Output on

2 = Output Over-Current Error
4 = Output Fault Error

Baseld + 4

Compound Id =3

Output 25 Status

Output 26 Status

Output 27 Status

Output 28 Status

Output 29 Status

Output 30 Status

Output 31 Status

~Njolu|h|lwNv|k|o|lo|N|o|u|h|lw|Nvk|o|lo|N|o|u|hwNvik|o|lo|N|o|lulhw Nk |o|o
CIOICIQIQICIQIQ@Q|QICIQ|QIQIQIQIO QOO0 |00/0/001010/0/01010/010|0
ENIENEENG ENT ENT ENTEN] S, | EN] EN] EN] ENTENTENTENE ENE 1§ ENT ENT EN] EN] ENJ ENT ENTENT T, FEND ENE ENE ENT ENT ENTEN] ENI RS I BN

Output 32 Status

0 = Output off

1 = Output on

2 = Output Over-Current Error
4 = Output Fault Error
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CANID

Byte

o8]
=

Channel

Scaling

Baseld +5

Compound Id=0

Input 1 Voltage

Input 2 Voltage

Input 3 Voltage

Input 4 Voltage

Input 5 Voltage

Input 6 Voltage

Input 7 Voltage

0to255=0to51V
0.2 V steps

Baseld +5

Compound Id =1

Input 8 Voltage

Input 9 Voltage

Input 10 Voltage

Input 11 Voltage

Input 12 Voltage

Input 13 Voltage

Input 14 Voltage

O0to255=0t0o 51V
0.2 V steps

Baseld +5

Compound Id =2

Input 15 Voltage

Input 16 Voltage

Input 17 Voltage

Input 18 Voltage

Input 19 Voltage

Input 20 Voltage

Input 21 Voltage

0to255=0to51V
0.2 V steps

Baseld +5

Compound Id = 3

Input 22 Voltage

NFRPOINIOOAR[WINIFP|IOINO|OTA|WIN|IRP[O|INO|OIA([W|IN[(F|O

o|o|o|olo|o|olo|o]o|o|o|o|o|o|o|o|o|o|o|o|o|o|o|o|o]e
0 Y 0 0 0 0 Y 0 0 Y 0 Y Y £ Y Y Y Y 1Y S Y

Input 23 Voltage

0to255=0t0o 51V
0.2 V steps
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Windows Keyboard Shortcuts

When using a laptop in and around a car, it is often not practical to use a
mouse to navigate through the program.

Using the keyboard to select options is easier.
Main Menu

File Edt “iew Onlne Toolz  Help MﬂTEC
d & + 1::% 1) ] B | R

To access the main menu, press ALT + the key for the underlined letter in the
menu, followed by the underlined letter of the item in the drop down menu.
E.g. ALT + F, N for Eile New.

Alternatively press and release ALT, select the desired menu item using the
arrow keys, press ENTER to activate it.

Closing a Window

Press ENTER for OK or Close (only when the OK or Close button has a bold
line around it)

Press ESC to Cancel or Close
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Selecting an Item in a Window

Setup | Channels

Charnrel

M arne: ||

Levels
Polarity: | Achive Low w

Channel iz falze when input voltage iz

above 4.2 — Y
for 010 — I
Channel iz true when input voltage is
below 3B o
far 010 —
[ ak. ] [ Cancel ]

To access the various items in a window, press ALT + the key for the
underlined letter of the item of interest, e.g. to select ‘Polarity’ press ALT + P

Alternatively use the TAB key to move through the dialog box (use SHIFT +
TAB to move backwards). The selected control is usually indicated by a
dotted line around it, or by highlighting the text or item selected within the
control.

Using the Selected Item

The method of using the selected item (or control) depends on the type of
control. The common controls are detailed below:

Check Box

Enable CAM Outputs

A check box is used to tick on or off a particular option.

Press ALT + the key for the underlined letter, or use the TAB key to navigate
to the Check Box. To select, press SPACEBAR.
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Command Button

Drefault |

Command buttons are generally used to show another screen or perform a
particular function.

Press ALT + the key for the underlined letter, or use the TAB key to navigate
to the command button. To select, press ENTER or SPACEBAR.

Drop-down List Box

Polarity: | Active Low W

A Drop-down list box is used to select from a number of items, but only the
selected item is shown until a new item needs to be selected.

Press ALT + the key for the underlined letter or use the TAB key to navigate
to the Drop-down List Box. To select the desired item, use the arrow keys and
press ENTER to close the list.

Group Box
() Channel
(%) Condition

The Group box is used to select an item from a group of options.

Press ALT + the key for the underlined letter, or use the TAB key to navigate
to the Group box. To select, use the arrow keys.

Tabs

setup | Channels
Tabs are used to select the different tab pages of a screen.

To select the next tab, press CTRL + TAB. To select the previous tab, press
CTRL + SHIFT +TAB.

Text Box

Channel

Mame: "

A text box is used to enter a value or text.
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Press ALT + the key for the underlined letter or use the TAB key to navigate
to the Text Box, type in the new value or text. Use the BACKSPACE or
DELETE to remove unwanted characters.

Tree Structure

Search:

= | Indicatars
+-00L | eft
+- 0 Right
=& POM

CAM Inputs

+-00 CAN Timeout

+ ﬂ Constants
A Global Error

+ ﬂ lnput Valtages
AL |nternal 95
Ol T ermperaturne
AL Takal Current

+
[Eal

K || Cancel |

A Tree Structure is used to select items from a hierarchical list

The UP ARROW key moves the cursor up (selects the item above)

The DOWN ARROW key moves the cursor down (selects the item below)
The RIGHT ARROW key expands; expandable branches indicated by a plus
sign (+)

The LEFT ARROW key collapses; collapsible branches indicated by a minus
sign (-)
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Glossary

MoTeC Devices

ACL
ADL2
ADL3
BR2
BTX
CIM
CLS
DBW4
E816
E888
i2

12 Pro
IEX
LTC
LTCD
M2R
M4
M400
M48
M600
M800

M800 Plug-In
M880

MDC
MDD
MLS

PCI cable
PDM15
PDM16

Advanced Central Logger

Advanced Dash Logger - second generation

Advanced Dash Logger - third generation

Beacon Receiver

Beacon Transmitter

Computer Interface Module

Central Logging System

Drive By Wire expander

Input/Output Expander

Input/Output Expander

MoTeC data analysis software

MoTeC data analysis software, professional version

Ignition Expander

Lambda to CAN module

Lambda to CAN Dual module

ECU dedicated to run 2 rotor engines

ECU for engines with up to 4 cylinders or up to 2 rotors

ECU for modern engines with up to 4 cylinders or up to 2 rotors
ECU for engines with up to 8 cylinders and 2 rotors

ECU for modern engines with up to 6 cylinders or up to 3 rotors

ECU for modern engines with up to 12 cylinders or up to 4
rotors

ECU for direct replacement of a factory ECU

ECU for modern engines with up to 12 cylinders or up to 4
rotors

Mitsubishi Diff Controller

Mini Digital Display

ECU dedicated to run Chevrolet LS1 and Lexus/Toyota V8s
PC Interface cable

Power Distribution Module with 15 outputs

Power Distribution Module with 16 outputs
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PDM30 Power Distribution Module with 30 outputs
PDM32 Power Distribution Module with 32 outputs
PLM Professional Lambda Meter

RTC Real Time Clock

SDC Subaru Diff Controller

SDL Sport Dash Logger

SGA Strain Gauge Amplifier

SLM Shift Light Module

SUU Software Update Unit

TCM Traction Control Module

UTC USB to CAN adaptor

VIM Versatile Input Module

Other

Calibration The process of converting an electrical value into a physical
value e.g. Volts into kilometres per hour

CAN Controller Area Network - communication protocol
CDI Capacitive Discharge Ignition

ECU Engine Control Unit

GPS Global Positioning System

MAF Mass Air Flow

MAP Manifold Absolute Pressure

PID Proportional, Integral and Derivative gain

PWM Pulse Width Modulated.

RPM Revolutions Per Minute

RS232 Recommended Standard 232, communication protocol
RX Receive

TDC Top Dead Centre

TX Transmit
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